
1. Press Command Key 2. Type Command 3. Press Enter Key

COMMANDS SUMMARY - OVERVIEW

Turn Command Key On and Off
NL + SP + f1 + f2 Turns command key on/off.  
 
Press all 4 keys together to turn on
Press all 4 keys again to turn off

1. Regular Commands.
All regular commands begin with the Command key, and finish with the Enter key.
To use any other regular command you follow this sequence;

If there is a space indicated in the command, you have to press the space key when
entering the command. Where numbers are needed in a command they can be entered
as either the Number sign plus character or alternatively as a  "dropped" or "lower"
character.

2.  Chorded commands 
Chorded commands use space bar pressed with designated letter.

Chord B Backtab
Chord C Carriage  return
Chord E End
Chord F Line feed
Chord H Help
Chord I Indent

Chord P Page eject
Chord R Reverse Line
Chord T Tab
Chord Z Stops the speech (while

speaking). 

Changing Between Learn Mode and Advanced Mode
ADV Advanced. The factory default setting is Learn Mode. It

will say “On” to indicate Advanced mode is on, and it will
say “Off” to indicate you are back in Learn Mode.

Speech Control
Recorded Speech

SPK R Selects recorded speech. This is the default.
SPK A  Speaks all keyboard keys, functions and commands. This

is the basis for the Learn Mode. As less speech is
required one of the following options can be used.

SPK C Speaks errors & prompts only. No braille dot keys
SPK D Speaks only braille dot keys. No function keys.

Synthetic Speech
SPK S Turns on Synthetic Speech. Available only in Advanced

Mode. 
No Speech

SPK N No speech. Tones only mode.



COMMAND SUMMARY - HANDY THINGS TO KNOW

Adjust Dot Height for Different Types of Paper
This function is used to match the impact force on the dots to the type of paper used.
For heavy braille paper, the impact force can be increased. For lighter paper, the impact
force can be decreased. The factory default setting is for regular photocopy paper
(lightweight paper).

CMD + RF Increase Impact
(speech prompt “Up”)

CMD + LF Decrease Impact (With
speech prompt “Down”)

Writing Braille on Cards or Small Paper

No Paper Operation
For use with small paper sizes (like a
birthday card). Press the Space and New
Line key together during a margin search. 

Using Heavy Card or Labels

You can choose from single strikes (default) up to 4 strikes on each dot.
MS [n]  Multi-strike feature. Set strikes per dot to "n".

Useful for brailling on heavy materials such as
plastic braille label. n = 1 to 4.  Default = 1

Check Battery Status
NL+SP+B To hear battery status
Press all 4 keys together

Check Trouble-Shooting Guide in
main manual

One-Handed Mode
KU  Turns on One Handed operation. Default = off. Toggle. 

When KU is on, press space bar after each character.

Notes: To turn KU off, remember to press K space U space.

Alternatives to Chorded Commands (for One-handed Mode)
These are regular commands using the Command key and Enter

BT  Backtab
CR Newline
IN Indent
LF Linefeed    

NP New Page
RL Reverse Linefeed
TB Tab
END   Close an open file



COMMAND SUMMARY - BRAILLE WRITING

Braille Formatting Commands
The following formatting commands apply in both Learn and Advanced Mode.

Position of Braille on the Paper
CE Centre Text. Embossing starts after the new line key is

pressed. Default = off. Toggle. 
RA     Right adjust braille (the braille will be printed from the

right hand margin). Default = off. Toggle
Margins

LM Set left hand margin to 0
LMH Set left margin to embossing head position.
LM n Set left margin to column ‘n’
RM Set right hand margin to 0
RMH Set right margin to embossing head position.
RM n Set right margin to column ‘n’
TM n Set Braille page Top Margin. n = number of lines.
BM n Sets Bottom Margin of Braille page. n = number of lines

for bottom margin.
Tab Settings

TSH Set tab at the position of the embossing head.
TC Clear all tab settings. 

Line Spacing
LS n[m] Line spacing. Default = 1. If you wanted line spacing of

1.5 lines then the command would be LS 1.5
Braille Writing Commands
The following formatting commands apply in both Learn and Advanced Mode.

COR   Correction Mode. Default = on. Toggle
EM        Turn embossing off and on. Default = on. Toggle
MAN   Choose between  Manual new line & Auto new line.

Default = Auto. Toggle
MS [n]  Multi-strike feature. Set strikes per dot to "n". Useful for

brailling on heavy materials such as plastic braille label. 
n = 1 to 4.  Default = 1

NP Force a New (Braille) Page. Page eject.
PN [n] Begin page numbering starting at value of "n".
PBELL [n] Set page bottom warning bell to ring "n" lines before the

end of the page.
RMBELL  Right margin bell. The bell rings 5 positions from the right

hand margin. Default = on. Toggle
SHOW  Emboss commands as they are entered. Can be helpful

for tracking mistakes. Default = Off. Toggle
WW     Word Wrap. When Word Wrap is on the word is not

embossed till the Space Key is pressed. Default = Off.
Toggle



COMMAND SUMMARY - BRAILLE WRITING

Braille Files in Memory
The following formatting commands apply in both Learn and Advanced Mode.
In the following commands [filename] means any name up to 16 characters long. 
Start a File

BEGIN [filename] Opens a new file, called "filename".
Close a File

END Close an open file. 
Alternatively you can simply turn the MB off and the open
file will be automatically saved.

Find Out Which Files You Have Stored in Memory
DIR Embosses all filenames and their sizes
FREE Embosses the remaining free memory space

Change the File
APPEND [filename]Append more information to "filename".
RENAME filename1 filename2

Rename "filename1" to "filename2".
Delete Files

DEL [filename] Delete the file named "filename". 
DEL ALL Delete all files.
UNDEL  Retrieve deleted file. Only works if used before turning

the unit off.
Emboss files that are stored in Memory

PR [filename] Print the file named "filename". Uses current settings.
MPR y [filename] Print "y" multiple copies of the file named "filename".

Miscellaneous Commands
VER Embosses Brailler software version.
HP Help.  Prints command summary
SAVE Saves all current settings. Use to save your preferred

settings (these will then become the default)
STD Restore back to factory default settings
ALT n Enables your MB to accept ASCII characters above 128.

‘n’ can be any ASCII value
Braille Graphics 

GF     Graphics mode.  The space between the dots is reduced.
Default = off. Toggle

Install Macros
The following 3 commands enable the 2 function keys to be used as for commands
that are selected bu the user.

KBLF Re-defines the left function key. Follow KBLF with new
command(s). If using multiple commands press NL (new
line key) between each command.

KBRF Re-defines the right function key. Follow KBRF with new
command(s). If using multiple commands press NL (new
line key) between each command.

KBLRF Re-defines third function (Left and right pressed together)



COMMAND SUMMARY  - Braille Exception Table 

Your MB has the flexibility to enable you to make exceptions to the standard braille
rules you are using, to use short cuts or abbreviations of your own choice, or to
introduce groups of contractions.

Braille Exception Table Commands
The following commands apply in both Learn and Advanced Mode. Up to 128
entries are allowed. The Braille Exception Table is active in both forward and back
translation. The commands for creating exceptions to the braille rules are as follows;

ETA  text braille position
Adds an entry to the exception table where;
text = the text to be changed
braille = the braille which will be substituted 
position = one or a combination of the five position indicators
given below:

b - allowed at the beginning of a word
m - allowed at the middle of a word
e - allowed at the end of a word
a - allowed anywhere
s - allowed only by itself (except adjacent to punctuation)

ETC  Clears the exception table
ETD  text Deletes an entry from the exception table where "text" is the text

to be changed
ETU    Turns the exception table off or on.  Default = on. Toggle

Braille Exception Table - Patterns Series
The following commands apply in both Learn and Advanced Mode.
For users in English Speaking Countries there is a new feature for the MB where
contractions are organised into 15 groups in accordance with the Braille Patterns
series developed by the American Printing House for the Blind, in Kentucky USA.
The command used to introduce one of the groups is;

PATTERNS n where ‘n’ is a number from 1 to 15

Note: The PATTERNS command only works when the
translation is set to Grade 1. Multiple groups can be
active simultaneously

1.   Alphabet and Letter Words
Upper Cell Contractions
2.   Whole or Part Words 
3.   Simulated Letter Words
4.   Part Word Signs
Lower Cell Contractions
5.   Simulated Letter Words
6.   Whole Words
7.   Middle Part Word Signs
8.   Beginning Part Word Signs

Multi-cell Contractions
9.   Dot 5 Whole & Part Words
10. Dot 4,5,6, Words
11. Dot 4,5, Words
12. Dot 4-6 Final Letter Contractions
13. Dot 5-6 Final Letter Contractions
14. Dot 6 Final Letter Contractions
15. Short Form Words



COMMAND SUMMARY - BRAILLE EMBOSSING 

Using Your MB as an Embosser
The MB Writer Plus and the MB Pro can be used as a regular braille embosser for note-
takers and PCs. Both models are compatible with note-takers such as the Braille Note,
Braille Lite and the Braille-n Speak. When using your MB as a braille embosser for a
PC it is recommended that a Windows based braille translation program such as Monty
or Duxbury be used.

Your MB can use single sheet or continuous feed paper, however, the MB will only
reliably emboss continuously if you use a lightweight paper (regular printer paper).

The MB Writer Plus and the MB Pro must be in Advanced Mode in order to use the
parallel or serial ports for connecting to the PC.

Using Continuous Paper
CP        Continuous paper feed. Default = off. Toggle
CPA ±n Add or subtract increment "n" to Form Length when using

Continuous Paper.

Paper Size
FL n[.m] Form Length. Sets physical length of page (in inches or

centimetres).
Page Numbering

PN [n] Begin page numbering, starting at value of ‘n’.

Control of Braille Output
EL n Allow only ‘n’ blank lines while embossing. Any lines

greater than ‘n’ will be discarded. This avoids having
large blank areas on your braille page.

CAP     Caps lock. Default = off. Toggle

The MB Writer only has one port which has been designed to use with the Mimic. If
you want to use it as a port to connect to a PC or braille note-taker, you must first
turn the Mimic function off, using the MIMIC command. (For additional information
refer to the Mimic section on Page 16).

With the Mimic function turned off, you can also use your MB Writer as an
embosser..



COMMAND SUMMARY - FORWARD TRANSLATION

The following commands apply in Advanced Mode only
Turn Forward translation on and off

FE           Forward translate and emboss. Toggle       
FM filename Forward translate and send to ‘filename’ in memory

(turns embosser off).
FM Append Forward translate and append to previously stored file

with the name ‘filename’.
FM END Closes file and turns forward translation off. And turns

embossing back on. 

Change Braille Grade or Code
FGR grade Select the Translation Grade, where ‘grade’ may be 1 or

2.  Default = 2.
FLN language  Change the Translation Rules language
FFC language , Foreign character selection. This enables insertion of

foreign or accented character into your text (without
changing the translation rules where [language] can be
one of the following codes;

OZ=Australian ITL=Italian  DAN=Danish  
NOR=Norwegian UK=English SP=Spanish FR=French
SWE=Swedish GER=German  USA=United States
GRK=Greek  DUT=Dutch FIN=Finnish POR=Portuguese

Formatting Your Braille
FLIT Literal Mode. Used for making columns and tables in

braille. Default = off. Toggle.
FLIT n Creates a Hanging Indent. The variable "n" gives the

number of indented spaces and can be 0, 1, 2, 3, 4, 5. 
FLIT S Suppresses blank lines as well as adding a two cell

indent for new paragraphs. Default = on
Italics 

FIT      When on, causes the subsequent text to be italicised in
Braille. Default = off. Toggle

Hyphens 
FHYP   When on, will break braille words at the end of a line.

Default is off. Toggle
Automatic Indent 

FIN         When FIN is turned on the current Braille column is
stored and  subsequent Braille lines are indented to that
column. Default = off. Toggle

Multiple Space Removal 
FSH     Replaces all multiple spaces and tabs that are in the text

with single spaces in the braille. Default = on. Toggle
Fraction Mode 

FFR  Causes fractions to be translated to Braille using lower
numeral sign for the denominator. A mathematical
separation sign is used after the Braille fraction if it is
followed by punctuation. Default = off. Toggle



Upper Case 
FCL   Used when translating capitalised or upper case text.

When on, prevents double capital sign before words all in
upper case. Default = off. Toggle

New Page 
NP Forces a new Braille page.

New Paragraph 
FPA Forces a new Braille paragraph. Used for flagging a new

paragraph that is coincident with the top of a text page.
Lists / Tables 

FLIST       Allows creation of simple lists or tables. This will produce
a table of three columns,  of 40%, 40% and 20% width.
For example: If your braille page is 40 cells wide then the
default will give three columns, each of cell widths 16, 16
and 8. Default = Off. Toggle

FLIST n1 n2 This command allows you to specify your own column
widths, as a percentage of the line length. The values
allocated to n1 and n2 will determine if you want two or
three columns. If the values of n1 and n2 add up to
exactly 100% then you will get two columns with widths in
the proportions specified. If they do not add up to 100%,
then you get three columns, of which the third column is
the remainder. .For three columns, the third column
cannot be greater than 90% or less than 10%. 

For example: 
FLIST 3 7 is ok. Gives 3 columns 3% 7% 90%
FLIST 50 50 is ok. Gives 2 equal columns.
FLIST 33 33 is ok. Gives 3 equal (33, 33, 34) columns
FLIST 5 4 gives an error. ( n1+n2 is less than 10%).
FLIST 50 45 gives an error. (n1+n2 greater than 90%).

Saving Your Preferred Settings
SAVE FT Saves all current Forward Translation settings, including

Braille Grade, language, and output settings.
STD FT Restores all default Forward Translation settings. Does

not interfere with stored settings.

RESTORE FT Restores all stored Forward Translation settings.



COMMAND SUMMARY - BACK TRANSLATION

Turning Back Translation On
BP Back translate to Parallel Port. Toggle

Use this when you have a regular printer connected to
the parallel/printer port. 

BS1 Back translate to S1 Serial port. Toggle
BS2 Back translate to S2 Serial port. Toggle

Changing the Braille Grade or Code Used
BGR [grade] Translation Grade, (may be 1 or 2). Default = 2.
BFC [language] Foreign character selection, where [language] can be one

of the following codes;
OZ=Australian,  ITL=Italian,   DAN=Danish,   
NOR=Norwegian,  UK=English,  SP=Spanish,  
FR=French,  SWE=Swedish,  GER=German,  
USA=United States,  GRK=Greek,   DUT=Dutch 
FIN=Finnish,  POR=Portuguese

Formatting Your Print Page
Automatic Indent 

BIN Causes all subsequent lines to indent to the current
cursor position.  Default = Off. Toggle

Centering 
BCE         When on, causes text to be centred between left and

right margins.  Default = off. Toggle
Columns and Tables

BLIT Literal Mode. When on, each new line in braille will
produce a new line in print. When off, a new line in braille
is ignored in the print copy (to avoid the print being
broken). Default = off. Toggle

BSH         Remove hard spaces. Causes multiple spaces and tabs
in your braille to be converted to single spaces and tabs
in the print. Default = Off. Toggle

Margins, Line Length, Paper Size
Left Margin 

BLM [n] Sets width of left margin to ‘n’ blank spaces from the left-
hand edge of the paper.  Maximum value of ‘n’ is 30.
Default = 8.

Right Margin 
BRM [n] Sets width of right margin to ‘n’ blank spaces from the

right-hand edge of the paper.  Maximum value of ‘n’ is
30. Default = 8.

Top Margin 
BTM [n] Sets a margin of ‘n’ blank lines at the top of the page

before printing begins.  The top margin may not exceed
the form length less the page length.  Default = 3.

Line Length
BLL [n] Sets the width of the print line, including margins, to ‘n’

characters, at 10 characters per inch. Maximum value of
‘n’ is 132.  Default = 80.



Form Length 
BFL [n] Sets the length of the page in "n" lines, at 6 lines to the

vertical inch.  The maximum value of "n" is 100.  Default
= 66.

Page Length 
BPL [n] Sets the number of printed lines on the page to "n" lines. 

The page length may not exceed the form length. 
Default = 60.

Upper Case Lock 
BCL Locks output text into upper case when on and returns to

normal echo of keystrokes when off.  Default = Off.
Toggle

Fraction Mode 
BFR Causes Braille fractions to be translated to text fractions

using the slash character to separate numerator &
denominator.  Requires use of Mathematical Braille
separation sign (Dot 6) between the fraction & any
subsequent punctuation. Default = Off. Toggle

Tabulation 
Tab Stop positions relate to printed output.
Default settings are  9, 17, 25, 33, 41, 49, 57, 65, 73 and 81.
BTBC Clears all current tab stops
BTBA [n] Sets an extra tab stop at position "n".

Line Spacing 
BLS [n] Sets the printer line spacing to "n", which may be from 1

to 10.  Default = 1.
Page Justification 

BPJ     When on, causes printed text to align with both margins. 
This may cause extra spaces to be inserted into text.
Default = off. Toggle

Right Alignment 
BRA      When on, causes printed text to align to the right margin. 

When off, text aligns to the left margin. Default = off.
Toggle

Page Numbering 
BPN [n] [p] Turns page numbering on or off at the desired position ‘p’

with a value of ‘n’. Max. value of ‘n’ is 1000, and
accepted position codes are:
TL - Top left BC - Bottom centre
TC - Top centre BR - Bottom right
TR - Top right OFF - Turn off  
BL - Bottom left ON - Turn on page numbering

BPNT [braille] Creates a text string to be printed with the page number,
where "braille" is the text to be printed.  Note: To position
text and turn numbering on and off , use the BPN
command, as given  above. Max. length of text is 15
characters, no punctuation allowed.



COMMAND SUMMARY - SYNTHETIC SPEECH

Turn on Speech Menu Exit the Speech Menu
NL + SP + S SP + E

From within the Speech Menu the following keys alter the speech as indicated. The
first time you press each character the current setting is announced. If you press the
same character again, you will scroll through the options available. The last spoken
setting then becomes the current setting.

Pitch, Volume and Rate.
DOT 6 Raise tone. It will say "higher" at the new pitch.
DOT 5 Faster speech. It will say "faster" at the new rate.
DOT 4 Increase volume. It will say "louder" at the new volume.

DOT 3 Lower tone. It will say "lower" at the new pitch.
DOT 2 Slower speech. It will say "slower" at the new rate.
DOT 1 Decrease volume. It will say "softer" at the new volume.

Speaking Mode
L ASCII (grade 0). Computer Braille notation.

Dot format. Letters spoken. Non-letters spoken
as dots

Translated format. This is the default setting.
Punctuation

P The 3 modes are Most, Some or None
Number Format

N Numbers being pronounced as digits or as complete numbers.
Speak Capital Letters

K Speak capital letters. Toggle
Speak Commands as You Type Them

C Either on or off
Keyboard Echo

E Press the letter  E to cycle through the 4 options;
Letters Each character is echoed as it is entered.
Word  The last word entered is echoed when the space,

carriage return and/or linefeed is entered.
Letters and Words
None No speech

Foreign Characters
F  Pressing the letter  F toggles between foreign letters being

spoken or not.   
Speak Spaces 

S Pressing the letter  S will toggle between spaces being spoken
as "space" or ignored.



COMMAND SUMMARY - THE EDITOR 

EDIT (filename) where [filename] is the name of the file you have stored
in memory (or the name of the new file if you are starting
a new one).

NL+Q Exit the editor
NL+H Help Menu. Default Off. Toggle

The MB will say "Entering Help mode". Press the Left
Function key to scroll through options. Press the right
Function key to scroll back through the menu options.

Moving Around Within A File
SP + DOT 3 Move to previous character and speak it
SP + DOT 2 Move to previous word and speak it
SP + DOT 1 Move to previous line and speak it
SP + DOTS 13 Move cursor to top of previous page
SP + DOTS 123 Move cursor to start of file
SP + DOTS 36 Speak current character. Pressing twice will give phonetic

equivalent or dot equivalent
SP + DOTS 14 Speak current line
SP + DOT 6 Move to next character and speak it
SP + DOT 5 Move to next word and speak it
SP + DOT 4 Move to next line and speak it
SP + DOTS 46 Move cursor to top of next page
SP + DOTS 456 Move cursor to end of file.

Other Chorded  Commands
SP + T TAB. Inserts a TAB at the cursor position in your file.
SP + P HARD PAGE BREAK. Forces a hard page break.
NL + I INSERT/OVERWRITE MODE.
NL + C CHANGING THE CASE OF TEXT.
NL + W WHERE AM I?:
SP + R SPEAK REST OF FILE
SP + Z SILENCE COMMAND 

Keyboard Commands. 
NL Newline key  is treated as a (hard) carriage return.
BS Backspace key is the same as the Read Last Character

command (sp + dot3), except when you are entering text in
response to a prompt, e.g. when asked for a filename, in which
case it will act as a true Back Space.

CMD Command Key will cancel any operation currently in progress.
Ent. Enter key has no meaning or function when using the editor.



MENU COMMANDS

FILE MENU - Enables file operations such as reading, saving, re-formatting etc.

NL+F Enter the File Menu: The File menu has the following options:

O OPEN A FILE AND MOVE IT TO  THE EDITOR
R RENAME THE FILE.
C CLEAR THE EDITOR WORK SPACE.
D GIVE DIRECTORY LISTING. You are placed at the top of the

file listing with the following supplementary commands available:
A  Speak the previous filename in the file listing.
C  Speak the current filename in the file listing
DOT 4  Speak the next filename in the file listing.
O  Open a file, at the current "file cursor" position, into the

editor.
D Delete the file at the current "file cursor" position.
F Give remaining  space in the editor buffer

P PROTECT / UNPROTECT THE FILE. 
F RE-FORMAT THE FILE.
S SAVE THE CURRENT EDITOR FILE.
SP + E EXIT THE MENU

EDIT MENU

NL+E Enter the Edit Menu: Edit menu has the following options.
S SIZE OF CURRENT FILE 
R REMAINING WORK SPACE
W WHERE AM I? Gives current page, line, cursor position.
F FORM NEW PARAGRAPHS.
J JOIN CURRENT AND NEXT PARAGRAPH.
D DELETE HARD PAGE BREAKS IN FILE
G GO TO a selected page number.
C ENTER MOUNTBATTEN COMMAND.
T TAKE AWAY MOUNTBATTEN COMMAND.

SP + E EXIT THE MENU

BLOCK MENU

NL+B Enter the Block Menu: You have the following options:
B BEGIN BLOCK marker.
E END BLOCK marker.
C COPY BLOCK to cursor position.
M MOVE BLOCK to cursor position.
P PASTE BLOCK.
S SPEAK BLOCK. Speak the contents of a block.
D DELETE BLOCK

SP + E EXIT THE MENU



DELETE MENU

NL+D Enter the Delete Menu: You then have the following options.
C DELETE CURRENT CHARACTER
W DELETE CURRENT WORD.
L DELETE CURRENT LINE.
P DELETE CURRENT PAGE.
Dot3 DELETE PREVIOUS CHARACTER 
Dots 256 DELETE TO END OF WORD
Dots 145 DELETE TO END OF LINE
R RESTORE LAST DELETION

SP + E EXIT THE MENU

SEARCH MENU

NL+S Enter the Search Menu: You then have the following options.
D DIRECTION OF SEARCH
C CASE SENSITIVITY OF SEARCH
W WORD MATCHING
S SEARCH FOR TEXT
R SEARCH AND REPLACE TEXT
L RESTART LAST SEARCH

Entering Search and Replace Strings
When you start a search, you are asked to enter the search string (the letters or
words that you are looking for). You may use any  alphanumeric or space character. 
The search and replace strings are terminated by Chord-E (sp + E).

The Search Sub-Menu
If your search string is found in the file and this is a search only command, then you
have available the following options:

W Speak word that contains search string.
L Speak line that contains search string.
N Ignore this one and find next.
Command Key Stop search and return to main search

menu.
sp+E Stop search and return to main editor

The Search and Replace Sub-Menu
If the search string is found and you have chosen to replace it,  you have available
the above Search sub-menu options as well as the following:

W Speak word that contains search string.
L Speak line that contains search string.
N Ignore this one and find next.
Command Key Stop search and return to search menu.
sp+E Stop search and return to main editor
R Replace this occurrence
A Replace all occurrences

A search can be abandoned, at any time, by pressing the Command key.


